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COLORADO LABORATORY- CERNER COMPUTER MANUAL
ACCESSION RESULT ENTRY
Overview

Use Accession Result Entry to enter results for General Laboratory procedures ordered on a single accession number.  You can select a specific ordered procedure and a test site to limit the information displayed for the selected accession number.  The individual discrete assays, included in the ordered procedure, display with columns for the result, result flags, result status, and previous results.  A check mark next to the result indicates that the result is selected when the perform or verify action is applied.
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Accession Result Entry has multiple result entry modes that allow the application to be used in different ways.  The modes include Accession, Differential, Instrument Queue, Worklist, and Correction.
While entering results, you can right-click to access a context menu for actions associated with the result, such as adding a comment or viewing previous results.  

The Post-It Note icon is displayed to indicate the presence of order comments.  Comments are easily accessed from the toolbar or a menu option.  All comments can be viewed and entered in the same window.

You can take a particular order from Accession Result Entry directly to Order Result Viewer.  From the View menu, select Go To Order Result Viewer.

Entering Results in Accession Mode

To enter results in Accession mode, you need to enter an accession number and, optionally, the ordered procedure name and the test site.  The procedures for which results are to be entered then is displayed, along with the information about the person for whom the procedure is ordered.  Multiple columns are displayed in the result portion of the window.  
1  In the Accession box, enter the accession number for which you want to enter results.
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2
If you want to limit the display to a single ordered procedure, enter the name of the ordered procedure in the Procedure box.  To display all ordered procedures for the accession number, leave the Procedure box blank.

3
If you want to limit the display to procedures performed only at the specified test site, enter the name of a test site in the Test Site box.

4
Click Retrieve or press ENTER to display the procedures for which results are to be entered.  Demographic information is displayed to the right of the accession selection information, and the procedures are listed in the bottom portion of the window.

· If the results have been received through an instrument interface or have been previously performed, they are displayed in the Result column of the spreadsheet.  Check marks are displayed next to the results.

· If the specimen has been repeated, multiple columns of results are displayed.  

· If you want to change the default result type for a procedure, select Convert Result from the Task menu or right-click to access context menu, and then select the appropriate result type.  

· The default result type for a procedure can be changed if necessary.  To convert a result type to another result type, right-click to access the Result context menu, then select Convert Result.  You can also access Convert Result from the Task menu.  The submenu under Convert Result displays the appropriate choices for the selected procedure.

· For a result type to be converted to an alpha response, the selected procedure must have alpha responses defined.  

· For a result type to be converted to a numeric type, the selected procedure must have a numeric format and reference ranges defined.

5
If the results are to be entered manually, type each result in the Result column and press ENTER to move to the Result box for the next procedure.  A check mark is automatically entered for each procedure whose result you enter.   

Note:
The result flags are applied as the results are entered and displayed in the Flags column.  If the result is received through an instrument interface, the flags are automatically applied. 
6
If you want to remove or add a single check mark, click that check box.  To apply check marks from all procedures, click the column header.  The check mark context menu can be accessed by either right clicking on the column header or on any check box.

7 If you want to add a result-level comment, select the procedure for which you want to add a comment, right-click, then select Comments from the result context menu.

8 When all results have been entered, click Perform.

9 Place your cursor in the accession box and click on the Retrieve button. Review all entered results for accuracy and click Verify.

Note:
The two step perform/verify process is necessary to ensure that automated calculations are performed by the system. The perform to verify step also gives the operator a last chance to check the accuracy of the entered results before verifying. ALWAYS PERFORM THEN VERIFY.
Reviewing Results in Instrument Queue Mode

The Instrument Queue mode is used to review and verify results received from an interfaced instrument.  As the results are posted by the interface, the accession number identifying those results is stored in an instrument queue.  You are able to move from one accession number to the next in the order in which the results were posted by the instrument.

1. In the Test Site box, enter your facility code.  Leave the procedure field blank.

2. Click the Start button to begin the search for accessions in the instrument queue.  Accession 
            Result Entry will search the instrument queue approximately every three seconds for an 
            available accession.  When an accession is found, the procedures and results are displayed.  
            Check marks are applied automatically.  The check mark context menu can be accessed by 
             right-clicking either the column header or any check box.

3. Review the displayed results.  A result can be changed and result-level comments can be added 
            from the result context menu, which can be accessed by right-clicking on any result.  

4. If you do not want to verify the displayed accession at this time, click the down arrow icon to
            skip to the next accession.  The skipped accession will remain in the queue and will be placed
            at the bottom of the queue list.

5. When you have finished reviewing the results, click Perform.

6. Finally, check the accuracy of the results and click Verify.  The accession is deleted from the queue when the results are verified.

Viewing Repeat Results

When a specimen has been repeated on an interfaced instrument, both the original result and the repeat result are displayed in Accession Result Entry.  For each set of results, the following columns are displayed:

· Check Mark

●  Result

· Flags


●  Status

The Previous and Time columns are displayed to the right of the last set of results.

All results with check marks are performed or verified, depending on which action is selected.  Individual results may be chosen from different columns by selecting the appropriate check boxes for each result.  When repeat results are displayed, no results will have check marks.  The following options are available for you to perform when there are repeated results:
· To select all results in a column, click the column heading of the check mark column.  

· If all results are to be performed/verified, click the heading of the check mark column for the results. 
Entering Differential Results

The automated differential results will populate from the instrument interface and display in PERFORMED mode when you bring up the results in ARE.  If you want to accept the automated differential results, you will simply click on the VERIFY button.  If, however, you want to perform a manual differential, you will need to:

1.  Change the DIFFERENTIAL result from AUTO to MANUAL and click on the PERFORM button in 
     ARE.  

2.  Access the PENDING INQUIRY function to transfer the manual differential from CORR Molis 

     WAM Orders (use the drop down in the Procedure box to enter Manual Differential) to your MOL 
     differential service resource (example COFR Differential).  

3.  Log the Manual Differential into your location through the Specimen Login function.  

4.  Finally you will access the manual differential in function ARE (Differential Mode).
NOTE: This example instructs you to enter the automated hemogram results.  In production, the results will populate through the instrument interface.
5.  In the accession number field of ARE, enter your CBC accession number.

6.  In the Test Site field, enter your instrument resource (i.e. COAR Act5 if MOL, CORR HST
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     Multi if RRL).

7.  Click on the RETRIEVE button. The hemogram portion of the CBC is displayed. 
8.  Enter the hemogram and auto differential portion of your CBC results. For the DIFFERENTIAL? 
     result, enter MANUAL.
9.  Click on the PERFORM button at the lower right portion of the screen.  Exit function ARE.
10.  Access the Pending Inquiry function.  Transfer the MANUAL DIFF from CORR DIFF to your 
       performing location (i.e. COAR Differential).
11.  Access the Specimen Login function.  Log the Manual Differential into your performing location 
       (i.e., AR Login).
12.  Access function  ARE.  From the MODE menu, click on DIFFERENTIAL.
13.  The differential screen is displayed with the SELECT ACCESSION box with the accession number 
       defaulted in the accession number field.
14.  In the Accession field, enter your accession number.  In the PROCEDURE field, enter CO Manual 
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       Differential.  In the OPTION field enter CO Manual Differential.
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15.  The differential screen is displayed with the hemogram and auto differential results on the left side of the screen.
16.  Perform you count using the keys specified for each cell type.  The system will display a message
       when you reach 100 cells. 
17.  Enter your morphology results by clicking in the result field next to the morphology component you
       want to enter.  The system will display the appropriate result options for each morphology
       component.
18.  To DESELECT the auto differential results by RIGHT clicking on the button to the left of the ABS
       NEUTRO AUTO field.
19.  Select DOWN.  Select DESELECT.  The auto differential results are unclicked (deselected).
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Entering a Result Level Comment

A result-level comment can be added to any result when the result is first entered or when a result is being corrected.  Predefined “canned” comments can be used.  Once the comment has been entered, the result must be performed, verified, or corrected for the comment to be saved.

1 Select the result to which the comment is to be added.

2 Select Comments from the View menu or from the result context menu (accessed by right clicking on the result).  The Comments dialogue box opens.

3 In the Comments dialogue box, select the appropriate tab and click Edit to open the editing window.  The Result Comment tab is for entering chartable comments.  The Result Note tab is for entering non-chartable comments.  The non-chartable result notes are available for viewing within the laboratory only.

4 Enter the comment.  

F2: To open the Select Template dialogue box, press F2.

F9: Alternately, type the canned comment code, then press F9.

F3: If the text of the canned comment needs to have information inserted, the underscore character displays where the information is to be inserted.  Press F3 to move from one underscore to another.

F5: If you want to insert the current system date and time, press F5.

5.
When you are finished adding or editing the comment, click OK to close the editing window.  

6.   Click Close to close the Comments dialogue box.  Verify that a red check mark is entered next to the
result.  A comment must have the check mark and the result must be performed, verified or corrected (depending on the mode you are in) to be saved.
Viewing Multiple Previous Results

While entering or reviewing performed results, you can also view previous results.  The most recent previous result is displayed in the window.  If you want to view more than one previous result for a selected procedure, these previous results can be viewed in another window.

1 Select Previous Results from the View menu or from the result context menu (accessed by right-clicking the result).  The Previous Results dialogue box opens and displays the last 15 results, if available, for the selected procedure.  The results are sorted by Collection Date/Time from newest to oldest.  If the current result is verified, it is displayed on the top line and is highlighted in yellow.

Note:
If Equivalent Assays have been defined for this procedure, the previous results for the equivalent assays are also displayed in the Previous Results dialogue box.  The Procedure column displays the name of the procedure.

2 Click Close to close the Previous Results dialogue box.

Viewing Patient Demographic Information

You can view additional patient demographic information, including date of birth and encounter history.  Complete the following steps to view patient demographic information:
1 From the View menu, select Patient Demographics.  The Patient Demographics dialogue box opens.

2 Review the information displayed.  Click Close to close the Patient Demographics dialogue.
Adding Service Resource to ARE

1.  Open ARE
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2.  Click on View, click on Customize, click on Result Display.
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3.  Check the box for Service Resource Display

[image: image4.png]K

ustomize Result Display:

Colurn Name Viskle
[Fiferense Range ]
Service Resouce Display %
Senvice Resaurce Descriptian ]





Viewing Container Details

You can view information about the containers for the selected accession by opening Container Inquiry.  Complete the following steps to view container details for the containers associated with the selected accession number:

1 From the View menu, select Container Details.  The Container Inquiry window opens.

Note: For more information about how to use Container Inquiry, open Container Inquiry Help from Help menu in Container Inquiry.
2 To exit Container Inquiry and return to Accession Result Entry, select Exit from the Task menu.  

Converting a Result Type 

1 Select the result to be converted. 

2 To convert a result type to a different result type, select Convert Freetext, Alpha, or Numeric from the Task menu in the Batch Result Entry window to indicate the new result type. 

· Result types can be converted to an alpha response only if alpha responses have been defined for the selected procedure. 

· Result types can be converted to a numeric type only if a numeric format and reference range has been defined for the selected procedure. 
Correcting Results
See Report Correction Policy in the QA Manual
NOTE:  Tests resulted by reference labs through an interface should not be changed by anyone except the reference lab.  When these tests need to be corrected the reference lab must reissue the report which will be resent through the interface as corrected.
Result Flags

The system automatically applies result flags in the Flags column, based on the numeric reference ranges or alpha response report flag defined for each procedure.  Numeric reference ranges include normal, critical, review, linear, and feasible ranges.  Alpha responses can be defined as abnormal, critical or review. Other flags displayed in the Flags column include the dilution factor, failed delta check, and comment.

Normal, Critical and Review

The normal, critical, and review flags are appended to a result when the result is less than the low value defined for the range or greater than the high value defined for the range.  If a result is flagged as critical, the text displaying the result is changed from black to red.

Linear

When a result is outside the linear range, the result value entered is stored in the system.  The displayed result is changed to the linear low or linear high value along with the appropriate less than or greater than symbol.    

Dilution Factor

When the linear range is defined in the system, a dilution flag can be set for the high linear range.  If the dilution flag is set, and the result is greater than the linear high value, the displayed result is not changed and the greater than symbol is not appended.  Enter a dilution factor for the result, and the system automatically calculates the new result.  

Feasible

When a result is outside the feasible range, you are warned that the result exceeds the defined feasible limits for the procedure.  If you accept the result anyway, the result comment window is opened and you are required to enter a comment.

Failed Delta Check

When the current result fails the delta check, the delta fail flag is displayed in the Flags column.  Delta check criteria can be defined based on species, gender, age, service resource, and result range.  The delta value and delta minutes are also defined for numeric results.  Alpha responses can be defined to use the Alpha Delta check type.

Comment

A chartable result comment or non-chartable result note can be appended to any result.  When either type of result comment is added, the comment flag is displayed in the Flags column.
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20.  Once you’ve completed the manual differential, click on the VERIFY results button in the lower right portion of the screen.











Written:  LIS Team 6/06
Page 1 of 11
Revised:  E. Gibson 7/11, B Marsh 18Aug15

[image: image12.png]


[image: image13.png]4 Differential Result Entry

Tesk Mode Vew Help

x| plw|

1 Hemogram r~Sekctonj3 Demogaptics
Procedure | Resut | 4| | 1.05130012 Manual D Young Fred Arapahos MedicalDffice (CD) / AR
¥ Insti WHL 100 ||
¥ WBC 85f Dption: £0 Manual Diff (Co852852743 ZZMHMD _ Test
¥ RBC 593
Cirs 150 Total clls o count [0 Chnse. ||| G3seas  Make Urknou Disgresis
¥4 Het 450
| Mev %0 2 Manual Diff 3 Morphology
M o Procedue | | | Resut| | Prev | Time 2l [ Procedwe | | Resut | | Prev | Time
CEer o Segs Man o 4 | [AbsNewroMan 7 53
e o Band Man 15 AbsLymphMan %4 1.9
CEE B LymphMan M 17 AbsMonoMan 4 1.0
& Differential?  Manusl Mooaeyte Men NV 11 P B oo H
ek ] e EosMan BV 8 AbsBasoMan 4 05 H
s eio At Basophiban V41 5 Oif Comment 54
4 s Lyngh Auko 40K A LymphMan G ¢ 3 Pletelt Comment 7 Count verified
Bastobian - 1 RBC Morph |
(51 Abs Eos Auto Mot 13 o SmudgeCels 1
it sotto Vyslo Man K21 Tasic Gran R
ﬂNE“‘mA“‘“ 500 PromyeloMan L 1 Tosic Vacuolation 11
T A NRECMan [ 4 5 Dol Badies =
OterCels  H Lot Pliclet Estinale 11
(51 Eos uto Gt Plackte -1
|1 Basophi o Hypochiom ]
Arisooytoss 2+ -
Pokiocytoss 412+ -
Mictocytes —=
Eliptacyes |
Mactocyles |
Ovalocytes =




[image: image14.png]" PathNet General Lal
Tosk Mode View Help

n Result Entry

Blm| @ials o]

el
P e i —

[

Frgcedur: Routine

Test Site: [CORR HST Multi _I



[image: image15.png]Select Accession
Accession [1-05-165.0003

Procedue: [Maral D =]
Optin 0 Hana D1 E

=




_1209455089

_1209454330

